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1. PREFACE 

 
In terms of its contents, Module E08 is part of the teaching unit entitled ’IT Communication with 
SIMATIC S7’. 

 
 

Fundamentals of 
STEP7 Programming 

2 to 3 days      Modules A

Industrial Field Bus 
Systems 

2 to 3 days Modules D 

Additional Functions of 
STEP7 Programming 

2 to 3 days Modules B

 
Process Visualization 

2 to 3 days Modules F 

Programming 
Languages 

2 to 3 days Modules C 

IT Communication 
with SIMATIC S7 
2 to 3 days Modules E

Plant Simulation with 
SIMIT SCE 

1 to 2 days  Module G 

Frequency Converter 
at SIMATIC S7 

2 to 3 days Modules H

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     Learning Objective: 
 
In Module E08, the reader learns how a safety-related application is started up on the PROFINET 
(PROFIsafe). On the PROFIBUS, the CPU 315F-2 PN/DP is used as IO Controller with an ET200S 
as IO device, in order to monitor the safety door at a press.  An Emergency Stop is also 
implemented with the ET200S.  Module E08 shows the method in principle, using a brief example.   
 
Prerequisites: 
 
To successfully work through Module E08, the following knowledge is assumed: 
 
• Knowledge in handling Windows  
• Fundamentals of PLC programming with STEP 7 (for example, Module A3 - 'Startup’  

PLC Programming with STEP 7) 
● Fundamentals of network engineering (for example, Appendix V - Basics of Network   
 Engineering)
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Hardware and software required 
 
1 PC, operating system Windows 2000 Professional starting with SP4/XP Professional starting 
 with SP1/Server 2003 with 600MHz and 512RAM, free hard disk storage 650 to 900 MB, MS 
 Internet Explorer 6.0  
2 Software STEP7 V 5.4 
3 Software S7 Distributed Safety V5.4 
4      PLC SIMATIC S7-300 with CPU 315F-2 PN/DP 

Sample configuration: 
 - Power supply: PS 307 2A 
 - CPU: CPU 315F-2 PN/DP 
5 Distributed periphery ET 200S for PROFIsafe with digital inputs and digital outputs 
 Sample Configuration: 
 -  Interface Module IM151-1 PN HF for interfacing with PROFINET 
 -  Power module PM-E DC 24V  
       -  Digital input module 2DI DC 24V for connecting a button and a switch 
       -  Digital input module 2DI DC 24V for connecting a feedback circuit of a consumer 
       -  Digital output module 4DO DC 24V/0.5A for connecting 2 lamps 
       -  Power module PM-E DV 24V …48V/AC24V…230V 
       -  Fault tolerant digital input module 4/8 F-DI DC 24V for connecting a 2-channel Emergency    
Stop and two safety door contacts 
      -  Fault tolerant digital output module 4 F-DO DC 24V/2A for connecting a consumer to two    
contactors K1 and K2 that can be switched off separately fail-safe. Here, the consumer is the    
supply voltage for a press. 
6 Ethernet connection between PC, CPU 315F2 PN/DP and ET200S with IM 151-3 PN HF 
7 Emergency Stop button 2-channel wired to the F-DI module of the ET200S  
8 Press with safety door; scan of safety door by means of two contacts wired to the F-DI module  
9 Connection lines to the model Press and to the Emergency Off button  
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Wiring Diagram 
 
 
 
 

 

Button 1:  Acknowledge 
 
Switch 2: Plant On 

Guard Door Contacts 
 
 
Emergency Stop 

Feedback Circuit 

Consumer/Press 
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2. NOTES ON USING THE CPU 315F-2 PN/DP 

 

 

The CPU315F-2 PN/DP is a CPU that is shipped with two integrated interfaces. 
• The first interface is an MPI/PROFIBUS DP interface that can be used on the  

PROFIBUS DP as master or as slave for connecting distributed IO/field devices with very fast  
 response timing. In addition, the CPU can be programmed here by means of the MPI or by 
 using PROFIBUS DP  
• The second interface is an integrated PROFINET interface  
 It makes it possible to use the CPU as PROFINET IO controller for operating distributed IO on 
 the PROFINET. The CPU can be programmed by means of this interface also! 
• At both interfaces, failsafe IO devices with PROFIsafe profile can be used.  
• Single bus concept; transmission of F-signals and standard signals by means of a bus  
 medium (PROFIBUS DP or PROFINET) 
• Fault tolerant IO modules of the ET200M/S/eco can be connected decentralized 
• Mixed configuration of F-modules and standard modules in one station 
• Field devices by other manufacturers can be connected. 
• Standard modules for applications that are not safety oriented can be operated centrally as 
 well as decentralized  
• Meets safety requirements up to SIL 3 according to IEC 61508, AK 6 according to DIN V 19250 
 and Kat. 4 according to EN 954-1 
• Standard as well as safety-relevant tasks can be solved with only one CPU  
 
The CPU 315F is based on a standard CPU (F means fault-tolerant) whose operating system was 
expanded by different protective mechanisms to allow for processing safety oriented user programs. 
This is needed for setting up fault-tolerant automation systems in plants with increased safety 
requirements. Fields of application are primarily production engineering.  The distributed IO devices  
ET200S PROFIsafe with fault-tolerant IO modules can be connected to the integrated PROFIBUS 
DP/PROFINET interfaces as well as external PROFIBUS/PROFINET CPs. Safety-oriented 
communication takes place by means of PROFIBUS DP/PROFINET with PROFIsafe profile. 
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Safety Concept 

 
 
The safety functions of the CPU 315F are contained in the CPU’s F-program and in the fail-safe 
signal modules. The fail-safe modules can be used in the distributed IO systems ET200M and 
ET200S. 
 
The fail-safe signal modules monitor output and input signals with discrepancy analyses and test 
signal injections. 
The CPU checks the correct operation of the controller through periodic self tests, instruction tests, 
as well as logical and time-related program execution checks. In addition, the IO is checked by life 
signs being requested.   
If an error is diagnosed in the system, the system is taken to a safe mode.  No f_runtime license is 
required for running the CPU 315F. 
 
In addition to the fail-safe modules, standard modules can also be used. 
This makes it possible to set up a fully integrated control system for a plant in which standard areas 
exist in addition to the safety-oriented areas.  
The entire plant is configured and programmed with the same standard tools. 
 
Programming 
 
The CPU 315F is programmed like other SIMATIC S7 systems. The user program for plant 
components that are not fail-safe is generated with the proven programming tools of STEP7.  
For programming the safety-oriented programs, the software package “S7 Distributed Safety V5.4” is 
indispensable. It contains all the elements you need for engineering.  
 
The CPU 315F is programmed with the STEP7 languages F-LAD and F-FBD. Here, the following 
safety functions can be implemented, for example: 
• User programmable safe combination of sensors and actuators 
• Selectively and safely switching off actuators 
 
 
The functionality regarding operations and data types is limited. 
Through a special input during compilation, a safety-oriented, password protected program is 
generated.  In addition to the fault-tolerant program, a standard program can also run parallel 
(coexistence) on a CPU that is not subject to restrictions.  
 
An additional part of this software package is the F-library with the pre-prepared program examples 
for safety-oriented functions, approved by the TÜV (German Technical Inspectorate).  The user can 
change these functions, but they have to be recertified. 
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Option Package S7 Distributed Safety 

 

 
The package contains all required functions and blocks for generating an F-program. For "S7 
Distributed Safety V5.4“ to run, STEP7 starting with V5.3+SP3 has to be loaded to the PG/PC. 
The F-program with the safety functions is wired in F-FBD or F-LAD, or with special function blocks  
from the F-library.  Using F-FBD or F-LAD simplifies configuring and programming the system; and, 
because of the system-overreaching, uniform representation, the acceptance inspection is simplified 
also. The programmer can concentrate completely on configuring the safety-oriented application, 
without having to use additional tools. 
 
Notes:   
- In Module E08, the CPU 315F-2 PN/DP is used on the PROFINET as IO controller. 
- F-modules as well as standard modules are incorporated. 
- A micro memory card is required for operating this CPU! 
- The addresses for the input and output modules can be parameterized at this CPU. 
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3. NOTES ON USING THE ET200S WITH IM 151-3 PN HF 

 

 

The SIMATIC ET200S is a decentralized IO device, configured in a highly modular mode.  It can be 
operated with different interface modules: 

IM 151-1 BASIC, IM 151-1 STANDARD and IM 151-1 FO STANDARD for connecting a maximum 
of 63 IO modules (all types except PROFIsafe) to the PROFIBUS DP; alternatively, bus connection 
with RS 485 Sub-D connector or by means of an integrated fiber-optic connection 

IM 151-1 HIGH FEATURE for connecting a maximum of  63 IO modules (all types, including  
clocked mode for PROFIsafe) to PROFIBUS DP; bus connection with RS485 Sub-D connector 

IM 151-3 PN for connecting a maximum of 63 IO modules (all types, except PROFIsafe) to 
PROFINET IO controllers; bus connection by means of RJ45 connector 

IM 151-3 PN HF (HIGH FEATURE) for connecting a maximum of  63 IO modules (all types; 
including the clocked mode for PROFIsafe) to PROFINET IO controllers; bus connection with 2 x 
RJ45 connector  

IM 151-7/F-CPU, IM 151-7/CPU or IM 151-7/CPU FO  for connecting a maximum of  63 IO modules 
(all types; PROFIsafe only with IM151-7/F CPU) to PROFIBUS DP; alternatively bus connection with 
RS 485 Sub-D connector or by means of an integrated fiber-optic connection; with integrated CPU 
314 of the SIMATIC S7-300, for preprocessing process data. 
 
The following IO modules can be used: 

Power modules for individual grouping of load and encoder supply voltages and their monitoring 
Digital electronic modules for connecting digital sensors and actuators 
Analog electronic modules for connecting analog sensors and actuators  

Sensor module for connecting IQ sense sensors 
Technology modules  Electronic modules with integrated technological functions, such as counting, 
positioning, data exchange, etc. 
Frequency converters and motor starter modules 
For training purposes, an integrated system is provided, suitable for teaching many technologies 
 
Notes:   
- In Module E08, the interface module IM151-3 PN HF is used as PROFINET IO device. 
-      F-modules as well as standard modules are inserted. 
- A micro memory card is required for running the IM151-3 PN HF! 
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4. STARTING UP PROFISAFE WITH THE CPU 315F-2 PN/DP AND ET 200S 

Below, the startup of a PROFIsafe application is shown.  The CPU 315F-2 PN/DP is used on the 

PROFINET as an IO controller, with an ET 200S as IO device, to monitor the safety door at a press.  

Emergency Stop is also implemented using the ET200S.  

 

1. The central tool in STEP 7 is the ’SIMATIC Manager’.  It is called here with a double click. (→ 

SIMATIC Manager) 
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2. STEP7 programs are managed in projects. We are now setting up such a project. (→ File → New) 
 

 
 
3. Now, we are assigning the ’Name’ ’CPU315F_PROFIsafe’ to the project. (→ 
CPU315F_PROFIsafe → OK) 
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4. Highlight your project and insert an ’Industrial Ethernet Subnet’. (→ CPU315F_PROFIsafe → 
Insert → Subnet → Industrial Ethernet) 

 
 

 
 
5. Then, after highlighting your station again, insert a ’SIMATIC 300 Station’. (→ 
CPU315F_PROFIsafe → Insert → Station → SIMATIC 300 Station) 
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6. With a double click, open the configuration tool for the ’Hardware’. (→ Hardware) 
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7. Now, open the hardware catalog by clicking on the symbol ' ’. (→ ) 

 

There, arranged in the directories: 
• PROFIBUS DP 
• PROFIBUS PA 
• PROFINET IO 
• SIMATIC 300 
• SIMATIC 400 
• SIMATIC PC Based Control  
• SIMATIC PC Station 
all racks, modules and interface modules are provided to configure your hardware. Insert ’Rail’ with 
a double click. (→ SIMATIC 300 → RACK 300  → Rail) 
 

 
 
After that, a configuration table is displayed automatically for configuring Rack 0. 
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8.  From the hardware catalog, you can now select all modules that are also in your real rack, and 
insert them in the configuration table. 
To this end, click on the name of the respective module, hold the mouse key and drag the 
module to a line in the configuration table. 

       We are starting with the power unit ’PS 307 2A’. (→ SIMATIC 300 →  PS 300 → PS 307 2A) 
 

 
 
Note: If your hardware differs from the one displayed here, simply select the corresponding modules 
from the catalog and insert them in your rack. The order numbers of the individual modules -that are 
also indicated on the components- are displayed in the footer of the catalog. 
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9. Next, we are dragging the ’CPU 315F-2 PN/DP’ to the 2nd slot. The order number and version of 
the CPU can be read off the front of the CPU. (→ SIMATIC 300 →  CPU 300 → CPU 315F-2 PN/DP 
→ 6ES7 315-2FH10-0AB0 → V2.3) 
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10  When entering the CPU, the window below appears. In this window, do the following: 

 

     Assign an ’IP Address’ to the CPU 315F-2 PN/DP, specify the ’Subnet Screen Form’, and       
select the ’Ethernet’ network that has already been generated.   

Optional: a ’Router Address’ can also be selected for network-overreaching communication.        
Confirm your input with ’OK’ (→ New → IP Address: 192.168.1.10 → Subnet screen form: 
255.255.255.0 → Ethernet(1) → Use Router →  Address: 192.168.1.1 → OK) 
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Notes on Networking on the Ethernet (additional information is provided in Appendix V of the 
training document): 

  
MAC Address: 
The MAC address consists of a permanent and a variable part. The permanent part ("Basis MAC 
Address") identifies the manufacturer (Siemens, 3COM, ...). The variable part of the MAC address 
differentiates the different Ethernet stations, and should be assigned uniquely world-wide. On each 
module, a MAC address specified by the factory is imprinted. 
 
Value range for the IP address: 
The IP address consists of 4 decimal numbers from the value range 0 to 255 which are separated by 
a period; for example 141.80.0.16 
 
Value range for the subnet screen form: 
This screen form is used in order to recognize whether a station or its IP address is part of the local 
subnet, or can be accessed only by means of a router. 
The subnet screen form consists of 4 decimal numbers from the value range 0 to 255 which are 
separated by a period; for example, 255.255.0.0 
In their binary representation, the 4 decimal numbers of the subnet screen form have to contain from 
the left a series of gapless values "1" and from the right a series of gapless values "0". 
The values "1" determine the area of the IP address for the network number. The values "0" 
determine the area of the IP address for the station address. 
Example:  
Correct values: 255.255.0.0 decimal = 1111 1111.1111 1111.0000 0000.0000 0000 binary 
    255.255.128.0 decimal = 1111 1111.1111 1111.1000 0000.0000 0000 binary 
    255.254.0.0 decimal = 1111 1111.1111 1110.0000 0000.0000.0000 binary 
Incorrect value: 255.255.1.0 decimal = 1111 1111.1111 1111.0000 0001.0000 0000 binary 
 
Value range for the address of the network transition (Router): 
The address consists of 4 decimal numbers from the value range 0 to 255 which are separated by a 
period; for example, 141.80.0.1.  
 
Relationship of IP addresses, router address, and subnet screen form: 
The IP address and the address of the network transition may differ only in positions that have a "0" 
in the subnet screen form. 
Example: 
You entered: for the subnet screen form 255.255.255.0; for the IP address 141.30.0.5, and for the 
router address 141.30.128.1.  
The IP address and the address for the network transition are to have a different value only in the 4th 
decimal number. In the example, however, the 3rd position already differs.  
In the example, you have to change alternatively: 
- the subnet screen form to: 255.255.0.0 or 
- the IP address to: 141.30.128.5 or 
- the address of the network transition to: 141.30.0.1 
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11. By double clicking on the ’CPU 315F-2 PN/DP’, you are opening its property catalog. (→ CPU 
315F-2 PN/DP) 
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12. Under the tab ’Protection’, do the following for setting the ’Protection Level’: 

 

• Below the option button ’1:  Access Protection for the F-CPU’, select the option 
’Can be canceled with a password’. 

• Activate the option button ’2: Write protection’. 
• Below the option button ’3: Write/read protection’, enter the password (8 characters 
 maximum) for the F-CPU; for example, "pw_fcpu". Repeat your input in the field 

‘Reenter’. 
• Activate the option box ’CPU contains safety program’. 
(→ Can be cancelled with password → Write protection → pw_fcpu → pw_fcpu → CPU contains 
safety program) 
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13. Under the tab ’Cycle/clock flag’, make the following settings: 

 

• At "OB85 call if there if an IO access error" select ’Only for coming and going errors’. 
• Activate the option box ’Clock flag’ and enter the '0’ as flag byte. 
 (→ Cycle/Clock flag → Only for coming and going errors → 0) 
 

 
 
14. Change to the tab ’Time Interrupts’ and set the call time for the time interrupt OB35. (The safety 
program is called at fixed time intervals in the time interrupt OBs.) (→ Time Interrupts → OB35 → 
50) 
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15. Move to the tab ’F-Parameters’ and set the following parameters: 

 

• The basis for the PROFIsafe addresses 
• A number band for F-data blocks 
• A number band for F-function blocks 
• The local data volume used by the F-system 
Confirm with ’OK’. (→ F-Parameter → OK) 
 

 
 
Note: When the safety program is generated, F-blocks are added automatically to generate a 
runnable safety program. For these automatically added F-blocks, you have to reserve a number 
band here.  
 
16. Now, close the message window for the necessary ’Regeneration of the safety program’. (→ 
Close → OK) 
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17. After you have accepted the network settings and the parameters of the ’CPU 315F-2 PN/DP’, a 
bar appears to the right of the CPU315-2 PN/DP, the ’PROFINET IO System’,  where you can 
arrange PROFINET IO devices.   
To do his, click on the desired module (here, the ’ET 200S’ with ’IM151-3PN HF’.) in the hardware 
catalog in the path ’PROFINET IO’ and drag it to the ’PROFINET IO System’. (→ PROFINET IO → 
I/O → ET 200S → IM151-3PN HF) 
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18. By double clicking on the ’IM151-3 PN HF’, you open its properties. (→ IM151-3 PN HF) 

 
 
19. To each IO device, a ’Device name’ that is unique within the PROFINET IO system has to be 
assigned, und an IP address on the ’Ethernet’. (→ Device name: IM151-3PNHF → Ethernet) 
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20. After you assigned the ’IP Address’, accept is with ’OK’.  
 (→ IP Address: 192.168.1.11 → OK → OK) 
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21. Now, the modules inserted in the ET200S have to be dragged to the configuration table and 
inserted there.   We are starting with the power module ’PM-E DC24V’; it is dragged to Slot 1. By 
double clicking on the ’PM-E DC24V’, its properties are opened. (→ PROFINET IO → I/O → ET 
200S → IM151-3 PN HF → PM → PM-E DC24V → PM-E DC24V) 
 

 
 
22. Under Parameters, activate the ’Diagnosis: Load voltage L+ missing’ with a . (→ 
Diagnosis: Load voltage missing L+ →  → OK) 
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23. Next, we are dragging the digital input module ’2DI DC 24V ST’ to the 2nd and the 3rd slot. The 
order number and the version can be read off the module. (→PROFINET IO → I/O → ET 200S → 
IM151-3 PN HF → DI → 2DI DC 24V ST → 2DI DC 24V ST) 

 
 
24. Then, we drag the digital output module ’4 DO DC 24V/0.5A ST’ to the 4th slot. The order 
number and the version can be read from the module. (→PROFINET IO → I/O → ET 200S → 
IM151-3 PN HF → DO → 4 DO DC 24V/0.5A ST) 
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25. Now, another power module ’PM-E DC 24...48V/AC 24...230V’ is taken to the 5th slot. The order 
number and the version can be read off the module. By double clicking on the ’PM-E DC 
24...48V/AC 24...230V’, its properties are opened. (→ PROFINET IO → I/O → ET 200S → IM151-3 
PN HF → PM → PM-E DC 24...48V/AC 24...230V → PM-E DC 24...48V/AC 24...230V) 

 
 
26. Under Parameters, activate the ’Diagnosis: Load voltage L+ missing’ with a . (→ 
Diagnosis: Load voltage L+ missing →  → OK) 
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27. Next, we are dragging the fail-safe digital input module ’4/8 F-DI DC 24V’ to the 6th slot. The 
order number and the version can be read off the module. Double clicking on the ’4/8 F-DI DC 24V’, 
opens its properties. (→PROFINET IO → I/O → ET 200S → IM151-3 PN HF → DI → 4/8 F-DI DC 
24V → 4/8 F-DI DC 24V)  

 

 
 
28. Under the tab ’Addresses’, you can change the module’s address areas.  However, it has to be 
ensured that identical values are assigned to the start addresses of the output and input data areas. 
(→ Addresses → 200 → 200) 
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29. Under the tab ’Parameters’, you can change the following parameter values: 

 

• F-Parameters for PROFIsafe 
• Module parameters 
• Channel-specific parameters 
Here, a 2-channel emergency stop switch is to be connected to channels 0 and 4, and the position 
switches for monitoring a 2 channel safety door to channels 1 and 5. Perform the following settings, 
and then accept them with ’OK’. (→ Parameters → OK) 
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Notes regarding "F-Parameters“: 

 

The PROFIsafe addresses have to be unique network-wide and station-wide. To prevent wrong 
parameter assignments, the addresses are assigned automatically. The PROFIsafe 
’F_Destination_Address’ has to be set at the F-module with a DIL switch. The PROFIsafe 
’F_Source_Address’ is specified by the F-CPU (F-Parameters  'Basis for PROFIsafe Addresses’). 
Within the monitoring time, a valid current safety message has to be received from the F-CPU.  
Otherwise, the F-module enters the safe mode. 
On the one hand, the F-monitoring time should be long enough so that message delays are 
tolerated; on the other hand, low enough so that the process can respond as fast as possible if there 
is an error, and continues running without detriment.  Help for establishing the timing is provided 
through calculation tables which SIEMENS is making available on the Internet   
(http://www4.ad.siemens.de/ww/view/de/ under the Contribution ID 19138505). 
Note regarding "Module Parameters":  
When a cyclical short circuit test is performed, you have to use the internal encoder supplies for all 
encoders connected to the F-module, und deactivate channels that are not used.  Otherwise, errors 
are recognized on these channels.  For our example, leave the settings of the module parameters 
unchanged. 
Note regarding "Channel x, y"  Parameters: ’Evaluation of the encoders’ and ’Type of encoder 
wiring’ are to be parameterized corresponding to the encoder wiring. Encoder wiring and the safety 
quality of the encoder are decisive for the attainable safety class. Deactivate the unused channels 2, 
6 and 3, 7. 
Note regarding 2of2 evaluation, discrepancy performance, and discrepancy time:  
If at two associated input signals (’2of2 evaluation’ of the encoders), different levels (if checked for 
non-equivalence: same levels) are recognized, the ’Discrepancy time’ that can be parameterized 
here starts. While the discrepancy time is running within the module, the ’last valid value’ or  ’0’     -
depending on how the discrepancy time was parameterized- is made available to the F-CPU by the 
affected input channel.  
 

 

30. Now, close the message window for the necessary ’Regeneration of the safety program’. (→ 
Close → OK) 
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31. Next, we are dragging the fail-safe digital output module ’4 F-DO DC 24V/2A’ to the 7th slot.  
The order number and the version can be read off the module. By double clicking on the ’4 F-DO DC 
24V/2A’, you open its properties. (→PROFINET IO → I/O → ET 200S → IM151-3 PN HF → DO → 4 
F-DO DC24V/2A → 4 F-DO DC24V/2A) 
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32. In addition to the ’Addresses’ that are changed here to 210, the following parameter values can 
be changed under the tab ’Parameters’: 

 
• F-parameters for PROFIsafe 
• Module parameters/channel specific parameters 
Here, on Channel 0, the press -our consumer- is to be operated indirectly by means of two 
contactors. Perform the following settings, and then accept them with ’OK’. (→ Parameters → OK) 
 

 
 
Note regarding "DO Channel x" parameters:  

 

Each output channel has its own parameterizable readback time. This time specifies the maximum 
duration of the shut-down test for the corresponding channel, and therefore also the readback time 
for the channel’s shutdown cycle. Use a wire break check for monitoring the connection from the 
output to the consumer.  Deactivate channels you are not using.  
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33. Now, close the message window for the necessary ’Regeneration of the safety program’. (→ 
Close → OK) 

 
 

 
 

34. By clicking on ' ’, the configuration table is saved and converted. (→  ) 
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35. Now, after being highlighted, the IO device has to be assigned the device name ’Assign device 
name’. (→ IM151-3PNHF→ PLC → Ethernet → Assign device name) 
 

 
 
Note: A precondition for this is that the PG/PC interface is set to TCP/IP and the network card of the 
PC is configured correctly.  For example, IP address 192.168.1.99, Subnet 255.255.255.0 and router 
address 192.168.1.1. (Refer to Module E02!) 
 
 

 

Note: Make sure that your programming device is connected to the ET200S by means of the 
Ethernet! 
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36. Now, the ET200S has to be selected in order to assign a name ’Assign name’. (→ ET200S → 
Assign name) 
 

 
 
Note:  If several IO devices are on the network, the device can be identified with the imprinted  
 MAC address. 
 
 
37. The new device name is then displayed in the area ’Available devices’. Then, ’Close’ the 
dialog. (→ Close) 
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38. By clicking on ' ’, the configuration table can be loaded to the PLC. The operating mode 

switch should be on Stop! (→ ) 
 

 
 
Note:  Make sure that your programming device is connected to the CPU by means of the Ethernet! 
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39. The CPU 315F-2 PN/DP is confirmed as destination module for loading the configuration table.  (
→ OK) 

 

 

 
 
40. In the dialog box below, you can have the devices displayed that are connected to the network  
’Display’. (→ Display) 
 

 
 

Preface                         Notes                         StartUp                         Programming 

Issued: 02/2008 PROFIsafe and PROFINET with IO Controller CPU 315F-2 PN/DP and IO Device ET 200S 



           Automation and Drives - SCE 
   

 
T I A  Training Document Page 41 of 64 Module 
E08 

41. Then, the CPU’s MAC address on the Ethernet network is selected. If you are connected to only 
one CPU, just accept with ’OK’ (→ OK) 

 
 

 
 
 

 

Note:  If there are several IO controllers on the network, the device can be identified with the  
 imprinted MAC address. 

 
 
42. Now, the correct IP address has to be assigned to the IO controller if it has not yet been set 

correctly.  Confirm this in the dialog box below with 'Yes’. (→ Yes) 

 
 

 
 
 
<<The selected station does not have an IP address. Do you want to assign the address 192.168.1.10 now?>>  
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5. PROGRAM EXAMPLE 

In the safety program below, a press as Consumer 1 is to be switched off safety-related for a 
production area if: 
• A safety door that is monitored by two contacts is opened or 
• An emergency stop connected to two-channels is operated  
After operating the emergency stop or after opening the safety door, a user acknowledgement on 
location is necessary in order to restart production. 
 
In our example  
- a fail-safe block with a safety door function,  
- an emergency stop function (safety circuit for shut down in the case of emergency stop, and 

open safety door)  
- a feedback circuit (as reactivation protection if the consumer is faulty), and  
- a user acknowledgement for reintegration  
is to be programmed and then generated into a safety program 
 
A precondition for programming this block is a hardware configuration that is set up correctly, as 
described in Chapter 4. 

  

 
 
F-IO Data Blocks 
For each F-IO, an "F-IO DB" is generated automatically in the hardware configuration during 
compiling and at the same time, a symbolic name is entered for it in the symbol table. You can view 
the  F-IO DBs generated for the sample IO in the block container; these are the F-data blocks DB 
601 and DB 602. 
The symbolic name of the F-IO DB consists of the permanent prefix "F", the start address of the F-
IO, and the names entered in the hardware configuration in the object attributes for F-IO (17 
characters maximum). 
F-Global DB 
The F-global DB "DB 600" is a fail-safe data block that is inserted automatically and contains all 
global data of the safety program, as well as additional information that the F-system needs.
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Inputs and Outputs in the Safety Program 

 

For programming the sample safety program, the following addresses and fault-tolerant IO DBs are 
available to you, according to the hardware configuration described in Chapter 4: 
You can access the variables of the F-IO DB by means of a "fully qualified DB access" 
(that is, by specifying the symbolic name of the F-IO DB and by specifying the name of the variable). 
Configured Hardware Start Address Symbolic Name F-IO DB 
Digital electronic module 
2DI DC 24V ST (6ES7 131-
4BB01-0AA0) 

0   

Digital electronic module 
2DI DC 24V ST (6ES7 131-
4BB01-0AA0) 

1   

Digital electronic module 
4DO DC 24V/0.5A ST 
(6ES7 132-4BD01-0AA0) 

0   

Fail-safe digital input 
module 4/8 F-DI DC 24V 
(6ES7 138-4FA01-0AB0) 

200 F00200_4_8_F_DI_DC24V DB 601 

Fail-safe digital output 
module F-DO DC 24V/2A 
(6ES7 138-4FB01-0AB0) 

210 F00210_4_F_DO_DC24V_2A DB 602 

 

 

1. Now, open the symbol table in your project. (→ Symbols)  
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2. In the symbol table, assign symbolic names to the fail-safe and the standard inputs and outputs as 

well as to the flags used. Save the symbol table and close it. ( →  → ) 
 

 
 
3. In the SIMATIC Manager, set up an F-FB. (→ Blocks → Insert new object → Function block) 
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4. Under the tab ’General – Part 1’, enter the ’Name’ and ’Symbolic Name’. As ’Programming 
Language’ select ’F-FBD’ and close the dialog field with ’OK’. (→ FB1 → FB_MAIN PROGRAM → 
F-FBD → OK) 

 
 

 
 
5. By double clicking in the SIMATIC Manager, open 'FB1’. (→ FB1) 
 

 
 

Preface                         Notes                         StartUp                         Programming 

Issued: 02/2008 PROFIsafe and PROFINET with IO Controller CPU 315F-2 PN/DP and IO Device ET 200S 



           Automation and Drives - SCE 
   

 
T I A  Training Document Page 46 of 64 Module 
E08 

6. Enter the password (8 characters maximum) twice and accept with ’OK’. (→ pw_fprog → 
pw_fprog) 

 
 

 
 
7. Now, in the editor ’LAD/STL/FBD’, set up a static variable with the name 'ENABLE_SAFETY 
DOOR’. (→ STAT →FRG_SCHUTZTUER) 
 

 
 

 

Note:  
The programming languages F-FBD and F-LAD basically correspond to the standard FBD/LAD. The 
standard FBD/LAD-Editor is used in STEP 7 for programming.  
F-FBD and F-LAD essentially differ from the standard through limitations in the operation set and 
regarding the usable data types and operand areas.   
The following is displayed in the F-program element catalog: 
• The operations that are supported 
• F-FBs and F-FCs from the block container of your S7 program 
• F-blocks from F-libraries, such as F-application blocks of the f-library Distributed Safety (V1), 
 for protective monitoring, etc. 
• Multi-instances 
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8. Now do the following: Insert the fail-safe application block FB 217 "F_SFDOOR" (safety door) 
from the block container ’F-Application Blocks’, set up the instance DB, and initialize the inputs 
and outputs, as shown in the figure below. (→ Libraries → F-Application Blocks → FB217 → DB217 
→ Yes)  

 

 

 
<<Instance data block DB217 does not exist. Do you want to generate it?>> 
 
The non-safe "acknowledgement button" signal from the standard program is marked yellow. 
 

 

Notes: If you need the Boolean constants "0" and "1" in your safety program for initializing 
parameters when calling blocks, you can access the variables "RLO0" and "RLO1" in the F-global 
DB by means of a fully qualified DB access ("F_GLOBDB".RLO0 or "F_GLOBDB".RLO1). In our 
example, the F-global DB has the number "DB 600" in the block container. 
In the case of fault-tolerant programming, the enable input EN and the enable output ENO must not 
be wired, initialized with "0“, or evaluated! 
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Connections of the FB 217: 
Inputs Parameters Data Type Description Default 
“HV01-S210“ IN1 BOOL Safety door  contact 1 0 
“HV01-S210“ IN2 BOOL Safety door contact 1 0 
"F00200_4_8_F_DI_DC24V".QBA
D 

QBAD_ IN1 BOOL QBAD signal from F-IO  
DB of input IN1* 

0 

"F00200_4_8_F_DI_DC24V".QBA
D 

QBAD_ IN2 BOOL QBAD signal of  F-IO  
DB of input IN2* 

0 

"F_GLOBDB".VKE1 OPEN_NEC BOOL Fully qualified access  to 
variable RLO1 from F-global 
DB** 

1 

"F_GLOBDB".VKE1 ACK_NEC BOOL Fully qualified access  to 
variable RLO1 from F-global 
DB** 

1 

"HV01-S220" ACK BOOL User acknowledgement (using 
the button) 

0 

Outputs Parameters Data Type Description Default 
#FRG_SCHUTZTUER Q BOOL Enable safety door 0 
 ACK_REQ BOOL Acknowledgement request 0 
 DIAG BYTE Service information B#16#0 
* = Both inputs QBAD_IN1 and QBAD_IN2 have to be wired; in our example both with the QBAD signal from the 
F-IO DB of the 4/8 F-DI, to which the safety door position switches are connected. You can obtain the block 
number of the F-IO DB by means of the symbolic name in the symbol table, or in the SIMATIC Manager. 
** = OPEN_NEC: 1 = OPEN required for startup/ACK_NEC: 1 = acknowledgement required. 
 
9. Set up the static variables "Enable_Safety Circuit“ (Freigabe Sicherheitskreis), "HM01" and 
"HM02" as auxiliary flags. Insert a 'New Network’, and generate a program for the safety circuit, as 
shown below (→ Enable_Safety Circuit → HM01 → HM02 → New Network) 
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10. In the ’SIMATIC Manager’, open the F-library Distributed Safety (V1) and copy the F-application 
block F_TOF (FB 186) from the block container ‘F-Application Blocks’\’Blocks’ to the block 
container of your S7 program. It is needed by the following fault-tolerant application block. (→ 
FB186) 

 

 

 
 
11. In your project, open the ’Object Properties’ of FB 186. (→ FB186 → Object Properties) 
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12. Assign the symbolic name ’F_TOF’ to the F-application block FB 186. (→ F_TOF → OK) 
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13. Set up a ’New Network’ and insert the fail-safe application block FB 216 "F_FDBBACK" 
(feedback monitoring) from the block container ’F-Application Blocks’.  Set up the instance DB and 
initialize the inputs and outputs as shown in the figure below. (→ New Network → Libraries → F-
Application Blocks → FB216 → DB216 → Yes) 
 

 

 
<<The instance data block DB 216 does not exist. Do you want to generate it now?>> 
 
Notes: If you need the Boolean constants "0" and "1" in your safety program for initializing 
parameters when calling blocks, you can access the variables "RLO0" and "RLO1" in the F-global 
DB by means of a fully qualified DB access ("F_GLOBDB".RLO0 or "F_GLOBDB".RLO1). In our 
example, the F-global DB has the number "DB 600" in the block container. 

 

In the case of fault-tolerant programming, the enable input EN and the enable output ENO must not 
be wired, initialized with "0“, or evaluated! 
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Connections of the FB 216: 

 
Inputs Parameters Data Type Description Default 
"Switch_ON" 
and 
#ENA_SafetyCircuit 

ON BOOL Enable conditions for 
Consumer 1/press 

0 

"HV01-S222" FEEDBACK BOOL Readback input 0 
"F00210_4_F_DO_DC24V_2A".Q
BAD 

QBAD_ FIO BOOL QBAD signal from F-IO DB of 
output Q* 

0 

"F_GLOBDB".VKE1 ACK_NEC BOOL Fully qualified access to the 
variable RLO1 from F-global 
DB** 

1 

"HV01-S220" ACK BOOL User acknowledgement 
(through button) 

0 

T#1s FDB_TIME TIME Readback time T#0ms 
Outputs Parameters Data Type Description Default 
"HV01-H100" Q BOOL Consumer 1/press 0 
 ERROR BOOL Readback error 0 
 ACK_REQ BOOL Acknowledgement request 0 
 DIAG BYTE Service information B#16#0 
* = In our example, this is the QBAD signal from the F-IO DB of the F-DO to which the consumer (the 
contactors) is connected. The block number of the F-IO DB can be obtained by means of the symbolic name in 
the symbol table, or in the SIMATIC Manager. 
** = ACK_NEC: 1 = Acknowledgement required. 
 

Preface                         Notes                         StartUp                         Programming 

Issued: 02/2008 PROFIsafe and PROFINET with IO Controller CPU 315F-2 PN/DP and IO Device ET 200S 



           Automation and Drives - SCE 
   

 
T I A  Training Document Page 53 of 64 Module 
E08 

14. Set up the static variable "HM03" as auxiliary flag. Insert a ’New Network’, and generate in your 
safety program for each F-IO a user acknowledgement for reintegration by means of the variable 
ACK_REI of the respective F-IO DB, as shown in the figure below. Then save the FB1500. (→ HM03 

→ New Network → ) 
 

 

 
 

 

Note: To reintegrate the F-IO (that is, to switch from the substitute values (0) to process values) after 
the errors are remedied, a user acknowledgement with a positive edge at the variable ACK_REI of 
the F-IO DB is required: 
- After communication errors always 
- After F-IO/channel errors only if  ACK_NEC = 1 is parameterized 
 
15. Confirm the following message with ’YES’ and close the FB1 and the FBD/LAD Editor. (→ Yes 

→ )) 

 

 
 
<<The interface of the block was changed. After the save, this causes an interface conflict with the blocks that 
reference this block. The associated F-blocks have to be recompiled. Continue the Save?>>
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16. Now, open the safety program. (→ Blocks → Options → Edit safety program) 
 

 
 
17. Then, click on ’F-Sequence Groups’. (→ F-Sequence Groups) 
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18. By clicking on ’New’, ’Specify a new F-sequence group’ and then perform the following 
settings  for the F-sequence group: 

 
• Specify the "FC1" as F-call block F-CALL for the new F-sequence group. This FC is set up 
automatically as soon as you exit the dialog field "Edit F-sequence groups” with "OK". 
• Specify the F-program block of the F-sequence group by selecting from the drop down menu 
the previously programmed FB that you want to specify as F-program block of the F-sequence 
group; in our example, "FB1". 
• Since in our example, the F-program block is a function block, assign an instance DB to it (for 
example "DB 1").  This I-DB is set up automatically as soon as you exit the dialog field  "Edit F-
sequence modules” with "OK". 
• Set "200 ms" as the maximum cycle time for the F-sequence group.  
Accept with ’OK’. (→ New → FC1 → FB1 → DB1 → 200ms → OK) 
 

 
 

 

Notes: The F-CALL is the F-block for calling the F-sequence group from the standard user program. 
The F-CALL contains the call for the F-program block and the calls for the automatically added F-
blocks of the F-sequence group.  Although you are setting up the F-CALL, you can not edit it.  
The program block is an F-FC or F-FB (with instance DB) that becomes an F-program block by 
being assigned to the F-CALL. You can do the following in the F-program block: 
• Program the safety program with F-FBD or F-LAD  
• Call additional, generated F-FBs/F-FCs for structuring the safety program  
• Insert F-blocks of the block container F-Application Blocks  
• Insert F-blocks from "User generated F-libraries" 
Within the F-program block, you determine the call sequence of the F-blocks. 
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19. When you have confirmed the automatic generation of the missing blocks with ’Yes’, return to 
the dialog field "Edit F-sequence groups”  which now looks like this. Close it with ’OK’.  (→ Yes → 
OK) 

 
<<Do you want to generate the missing blocks (F-CALL block, I-DB for F-program block, data block for F-
sequence group communication)?>> 
 
20. The safety program is prepared, but not yet generated. The overall signature of all F-blocks with 
F-attribute of the block container and the overall signature of the safety program differ. Now, 
’Generate’ your safety program. (→ Generate) 
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21. When the safety program is generated, a consistency check of the sequence-relevant F-blocks is 
performed; that is, the safety program is checked for errors. Possible error messages are read out in 
an error window. After the successful consistency check, the F-system blocks that are needed in 
addition are generated automatically and added to the sequence group, in order to generate a 
runnable safety program.  Now, ’Close’ the message list. (→ Close) 

 
 
22. After generation was successful, a consistent safety program that consists of all F-blocks with F-
attribute is always present in the block container. The ’Overall signature of all F-blocks with F-
attribute of the block container’ and the ’Overall signature of the safety program’ are now the 
same.  You now have a consistent safety program that is valid for acceptance. Confirm with ’Close’. 
(→ Close) 
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23. The safety program is entered by calling FC1 "F-CALL“ from a time interrupt OB. To this end, set 
up OB35 in the SIMATIC Manager. (→ Blocks → Insert new object → Organization block → OB35 
→ OK)  
 

 

 
 

 

Note: Time interrupt OBs have the advantage that they interrupt cyclical program processing in OB1 
of the standard user program at fixed time intervals; that is, in a time interrupt OB, the safety 
program is called and executed at fixed time intervals. After the safety program has been processed, 
the standard user program continues to be processed. 
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24. Open ’OB35’ by double clicking in the SIMATIC Manager. (→ OB35) 

 

 

 
 
25. Call FC1 "F-CALL“ in the time interrupt OB35 as shown in the figure below. Save and close 

OB35. (→ Call FC 1 →  → ) 
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26. Open ’OB1’ by double clicking in the SIMATIC Manager and select ’FBD’ as ’Programming 
language’. (→ OB1 → FBD → OK) 
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27. From the standard program, program the activation of flag M10.0 for switching on the press in 

the operational mode.  Save OB1 and close it. (→  → ) 
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28. Open the safety program again. (→ Blocks → Options → Edit safety program) 
 

 
 
29. Click on the button ’Load’. (→ Laden) 
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30. Confirm the inquiry whether the F-CPU is to be switched to the operating mode STOP with ’Yes’. 
(→ Yes) 

  

 
<<Consistent loading of failsafe blocks is possible only when the F-CPU is in STOP. Do you want to switch the 
F-CPU into the STOP mode?>> 
 
31. Confirm the inquiry whether the standard blocks are also to be loaded with ’Yes’. (→ Yes) 

 
<<Are the standard blocks contained in the block folder (except for the system data blocks) to be loaded also 
during this loading procedure?>> 
 
32. Enter the password. (→ pw_fcpu → OK) 

 
 
33. Confirm the inquiry whether the F-CPU is to be started with ’Yes’. (→ Yes) 

 
<<The F-CPU is in the STOP mode.  Do you want to start the F-CPU now?>> 
 
Notes: If you are loading only the F-blocks, the block from which the F-CALL block is called (in our 
example, the time interrupt OB35) is not loaded. You will have to load this OB separately, as in the 
standard case.  
The complete safety program can only be loaded in the STOP mode. 
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34. In the dialog field ’Safety Program’, activate successively the option buttons ’Offline’ and 
’Online’, and check whether the overall signatures of all F-blocks with F-attribute of the block 
container match online and offline. If it is a match, loading was successful.  If not, reload.  (→ Online 
→ Offline → Close) 
 

 
 
35. To activate the safety mode, take the F-CPU from STOP to RUN. 
 
Note: After you have generated the safety program, a complete function test corresponding to your 
automation task has to be performed. 
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